
เล่มที่ 1 เรื่อง เริ่มต้นกับ Photoshop CS6

ชุดการเรียนรู้ เรื่อง การใช้งานโปรแกรม Adobe Photoshop CS6
รายวิชาคอมพิวเตอร์ 3 รหัสวิชา ว22282 
ของนักเรียนชั้นมัธยมศึกษาปีที่ 2 

นางสุจิตรา  อนันตนมณีี
ตำแหน่ง  ครู  วิทยฐานะ ครูชำนาญการพิเศษ
โรงเรียนสะแกราชธวัชศึกษา  อำเภอปักธงชัย  จังหวัดนครราชสีมา
สำนักการศึกษา  ศาสนาและวัฒนธรรม  องค์การบริหารส่วนจังหวัดนครราชสีมา
กรมส่งเสริมการปกครองท้องถิ่น  กระทรวงมหาดไทย
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. เอกสารฉบับนี้เป็นชุดการเรียนรู้ เรื่อง การใช้งานโปรแกรม Adobe Photoshop 

CS6 รายวิชาคอมพิวเตอร์ 3 รหัสวิชา ว22282 ชั้นมัธยมศึกษาปีที่ 2 

2. ชุดการเรยีนรู้ เล่มนี้ประกอบด้วย 

-  คำชี้แจงเกี่ยวกับชุดการเรียนรู้ 

          -  คำแนะนำสำหรับครู 

                  -  คำแนะนำสำหรับนักเรียน 

                  -  แผนผังแสดงขัน้ตอนการศึกษาชุดการเรียนรู้ 

                  -  สาระสำคัญ 

  -  ผลการเรียนรู ้

                  -  จุดประสงค์การเรียนรู้ 

                  -  แบบทดสอบก่อนเรียน 

                  -  กระดาษคำตอบแบบทดสอบก่อนเรียน 

                  -  บัตรเนื้อหา 

                  -  บัตรกิจกรรม 

                  -  แบบทดสอบหลังเรียน  
                -  กระดาษคำตอบแบบทดสอบหลังเรียน 
                  -  เฉลยแบบทดสอบก่อนเรียน 

                -  เฉลยแบบทดสอบหลังเรียน 
                -  บัตรเฉลยกิจกรรม 
           3. ชุดการเรียนรู้ เรื่อง การใช้งานโปรแกรม Adobe Photoshop CS6 รายวิชา

คอมพิวเตอร์ 3 รหัสวิชา ว22282 ชั้นมัธยมศึกษาปีที่ 2 เล่มนี้ใช้เวลาในการเรียน 2 ชั่วโมง 

 

 

 
 

 

    คำชี้แจงเกี่ยวกับชุดการเรียนรู้ 
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. ครูควรจัดเตรียมชุดการเรียนรู้ซึ่งประกอบด้วย บัตรคำสั่ง บัตรเนื้อหา บัตรกิจกรรม 

และบัตรเฉลยกิจกรรม ตลอดจนอุปกรณ์ต่าง ๆ ให้ครบถ้วน 

 2. ให้นักเรียนทำแบบทดสอบก่อนเรียน เพ่ือประเมินความรู้เดิมของนักเรียน 

 3. แจ้งจุดประสงค์การเรียนรู้ให้นักเรียนทราบ 

 4. แจกชุดการเรียนรู้ให้นักเรียนได้ศึกษาและแนะนำวิธีใช้ชุดการเรียนรู้ เพ่ือนักเรียน

จะได้ปฏิบัติได้อย่างถูกต้อง 

 5. ดำเนินการสอนตามกิจกรรมการเรียนรู้ทีก่ำหนดในแผนการจัดการเรียนรู้ 

 6. หากมีนักเรียนบางคนเรียนไม่ทันครูควรให้คำแนะนำ หรือมอบหมายงาน                 

หรือเอกสารให้ศึกษาเพ่ิมเติมในเวลาว่าง 

 7. หลังจากนักเรียนศึกษาชุดการเรียนรู้เสร็จเรียบร้อยแลว้ ครูและนักเรียน 

ควรช่วยกันสรุป และให้นักเรียนทำบัตรกิจกรรม และทำแบบทดสอบหลังเรียน 

 8. ครูเฉลยบัตรแบบฝึกหัด แบบทดสอบก่อนเรียน-หลังเรียน และบันทึกคะแนน              

ของนักเรียนแต่ละคนไว้เพ่ือประเมินการพัฒนาและความก้าวหน้า หากมีผู้เรียนไม่ผ่านเกณฑ์ 

ครคูวรจัดสอนซ่อมเสริม 

 9. การจัดชั้นเรียนจะจัดให้นักเรียนนั่งเป็นรายบุคคลหรือกลุ่มก็ได้ 

 

  

 

  

 

 

              คำแนะนำสำหรับครู 
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 1. อ่านคำชี้แจงและคำแนะนำสำหรับนักเรียนให้เข้าใจก่อนจะลงมือศึกษาชุดการเรียนรู้ 

2. ทำแบบทดสอบก่อนเรียน จำนวน 10 ข้อ โดยใช้เวลา 15 นาที เพ่ือประเมินความรู้

เดิมของนักเรียน 

3. ศึกษาชุดการเรียนรู้จากบัตรเนื้อหาที่ครูจัดเตรียมไว้ด้วยความตั้งใจ โดยปฏิบัติตาม

ขั้นตอนที่กำหนดไว้ในบัตรคำสั่ง 

4. เมื่อนักเรียนศึกษาบัตรเนื้อหาให้เข้าใจอย่างถ่องแถ้ หากเกิดข้อคำถาม ควรจดบันทึก

ไว้แล้วสอบถามครูภายหลัง และฝึกปฏิบัติกิจกรรมตามท่ีกำหนดให้โดยไม่ข้ามขั้นตอน  

5. หากผู้เรียนยังไม่เข้าใจในบัตรเนื้อหา ให้กลับไปศึกษาใหม่อีกครั้ง เพ่ือให้เกิดความ

เขา้ใจมากยิ่งขึ้น 

6. ทำแบบทดสอบหลังเรียน จำนวน 10 ข้อ เพ่ือเปรียบเทียบความก้าวหน้าในการเรียน

ของนักเรียน 

 7. ในการทำบัตรกิจกรรมและแบบทดสอบต่าง ๆ ทำด้วยความตั้งใจและมีความซื่อสัตย์

ต่อตนเองให้มากทีสุ่ด โดยไม่ดูเฉลยก่อนทำแบบฝึกหัดและแบบทดสอบ 

 8. นักเรียนจะทำเสร็จช้าหรือเร็ว ขึ้นอยู่กับความสามารถและทักษะของนักเรียนเอง        

ไม่จำเป็นต้องทำเสร็จพร้อมกัน 
 

 

              คำแนะนำสำหรับนักเรียน 
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                              เริ่มต้นกบั Photoshop CS6 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

                 สาระสำคัญ  

 ส่วนประกอบสำคัญท่ีเราต่างได้พบเห็นอยู่ในรูปแบบของแผ่นโฆษณา งานพรีเซนเดชั่น  
                      กล่องสินคา้ และเว็บไซต์ต่าง ๆ ทำให้ผู้ชมเกิดความสนใจในสิ่งที่นำเสนอ พร้อมทั้งกับเข้าชม 

                      และใช้บริการเหล่านั้น และท่ีใกล้ตัวมากขึ้น คือ การตกแต่งภาพแต่ง ที่เราสามารถตกแต่ง 

                      ในโอกาส และบรรยากาศต่าง ๆ ให้ออกมาอย่างน่าสนใจ ดังนั้นเนื้อหาในบทแรกนีจ้ะเริ่มต้น 

นำเสนอให้รู้จักกับภาพกราฟิก การทำงานกับกราฟิกบนคอมพิวเตอร์ และความสามารถใน  

การสร้างงานกราฟิกของโปรแกรมยอดนิยมอย่าง Adobe Photoshop 

            

      

 

  

  นำเสนอ 

 

 
 
 

       1. นักเรียนบอกความหมายของคอมพิวเตอร์กราฟิกได้ 

       2. นักเรียนอธิบายการเกิดภาพในคอมพิวเตอร์กราฟิกได้ 

       3. นักเรียนอธิบายการประมวลผลภาพในคอมพิวเตอร์กราฟิกได้ 

       4. นักเรียนอธิบายความสามารถโดยรวมของ Adobe Photoshop CS6 

       5. นักเรียนอธิบายส่วนต่าง ๆ บนหน้าจอโปรแกรม Adobe Photoshop CS6  

          และเรียกใช้งานได้ 

       6. นักเรียนนำเข้าไฟล์จากกล้องดิจิตอลและสแกนเนอร์ได้ 

       7. นักเรียนสร้างไฟล์ใหม่และบันทึกไฟล์ใหม่เบื้องต้นได้ 

 

  

 

  
 

 

              ผลการเรียนรู้  
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                              เริ่มต้นกบั Photoshop CS6 

 

 
     

 
 
 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

ด้านความรู้ (K)  

       1. นักเรียนสามารถอธิบายส่วนประกอบของโปรแกรม Adobe Photoshop CS6 ได ้ 

       2. นักเรียนรู้จักกล่องเครื่องมือของโปรแกรม Adobe Photoshop CS6 ได้ 

       3. นักเรียนรู้จักหน้าที่และใช้งานพาเล็ต แถบสถานะ และพ้ืนที่ใช้งานของ 

โปรแกรม Adobe Photoshop CS6 ได้ 

       4. นักเรียนสามารถบอกวิธีการเปิดใช้งานโปรแกรม Adobe Photoshop CS6  

และสามารถเปิดใช้งานโปรแกรมได้ 

 

ด้านทักษะกระบวนการ (P)  

1. นักเรียนสามารถเปิดการใช้งานโปรแกรม Adobe Photoshop CS6  

และสามารถเปิดใช้งานโปรแกรมได้ 

 2. นักเรียนสามารถสร้างไฟล์งานใหม่ได้ 

3. นักเรียนสามารถบนัทึกไฟล์ภาพในรูปแบบ JPEG ได้ 

 

ด้านคุณลักษณะ (A)  

1. นักเรียนมีความรับผิดชอบต่องานที่ได้รับมอบหมาย 

 2. นักเรียนมีความมุ่งมั่นในการทำงาน 

3. นักเรียนมีความขยันและซื่อสัตย์ 

4. นักเรียนมีระเบียบวินัย ทำงานอย่างเป็นระบบ รอบคอบ 

 

ด้านคุณลักษณะ (A)  

1. นักเรียนมีความสามารถในการสื่อสาร 

 2. นักเรียนมีความสามารถในการใช้เทคโนโลยี 

 

 

 

 

 
 
 

 

 

 

จุดประสงค์การเรียนรู้ 
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

แผนผังแสดงขั้นตอนการศกึษา 

ชุดการเรียนรู้ เรื่อง การใช้งานโปรแกรม Adobe Photoshop CS6 

มีดังนี ้

 

อ่านคำชีแ้จง และคำแนะนำ 

ศึกษาสาระสำคัญ ผลการเรียนรู้ และจุดประสงค์การเรียนรู้ 

ทำแบบทดสอบก่อนเรียน 

 

ศึกษาบัตรคำสั่ง บัตรเนื้อหา และบัตรกิจกรรม 

ทำแบบทดสอบหลงัเรียน 

ศึกษาชุดการเรียนรู ้เล่มต่อไป 

ไม่ผ่านเกณฑ์ 

 

ผ่านเกณฑ์ 
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

ให้นักเรียนปฏิบัติตามข้ันตอนตอ่ไปน้ี 

 
1. เลขานุการแต่ละกลุ่มส่งตัวแทนออกมารับชุดการเรียนรู้  เรื่อง การใช้งาน

โปรแกรม Adobe Photoshop CS6 รายวิชาคอมพิวเตอร์ 3 รหัสวิชา ว22282  

ชั้นมัธยมศึกษาปีที่ 2 เล่มที่ 1 เรื่อง เริ่มต้นกับ Photoshop CS6 จากครู 

2. ให้นักเรียนแต่ละคนศึกษาสาระสำคัญ ผลการเรียนรู้ จุดประสงค์การเรียนรู้             

บัตรคำสั่ง และทำแบบทดสอบก่อนเรียน จำนวน 10 ข้อ 

3. ให้นักเรียนศึกษาบัตรเนื้อหา ทำบัตรกิจกรรม ตรวจผลงานที่บัตรเฉลยกิจกรรม 

4. ถ้าไม่เข้าใจให้ศึกษาจากบัตรเนื้อหาอีกครั้งหนึ่ง 

5. นักเรียนทำแบบทดสอบหลังเรียน จำนวน 10 ข้อ 

 

 

                         บตัรคำสั่ง 
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 

 

 

 

 

 
 

 

 1. โปรแกรม Adobe Photoshop CS6 เป็นโปรแกรมประเภทใด 

ก. โปรแกรมฐานข้อมูล 

ข. โปรแกรมแกลอรี่ภาพ 

ค. โปรแกรมนำเสนอภาพ 

ง. โปรแกรมคอมพิวเตอร์กราฟิก 
 

2. ข้อใดวิธีเปิดใช้โปรแกรม Adobe Photoshop CS6 

ก. Start -> Run -> Adobe Photoshop CS6 

ข. Start -> Setting -> Adobe Photoshop CS6  

ค. Start -> All Programs -> Adobe Photoshop CS6 

ง. Start -> Control panel -> Adobe Photoshop CS6 
 

3. ความสำคญัของงานกราฟิกคืออะไร 

ก. เพ่ือช่วยในการสร้างเว็บไซต ์

ข. เพ่ือช่วยในการแตกแต่งภาพ 

ค. เพ่ือช่วยให้คุณภาพของงานดีขึ้น 

ง. ถูกทุกข้อ 
 

4. ข้อใดคือไฟล์ของโปรแกรม Adobe Photoshop CS6 

ก. PDS 

ข. AVI 

ค. ACDC 

ง. MPEG 

 

 

  แบบทดสอบก่อนเรยีน 

เร่ือง การใช้งานโปรแกรม Adobe Photoshop CS6 

รายวิชาคอมพิวเตอร์ 3 รหัสวิชา ว22282  

ชั้นมัธยมศึกษาปีที่ 2  

เล่มที่ 1 เร่ือง เร่ิมต้นกบั Photoshop CS6 

 

 คำชี้แจง  แบบทดสอบแบบปรนัย 4 ตวัเลือก จำนวน 10 ข้อ ให้นักเรียนเลือกคำตอบทีถู่กต้อง 

            ที่สุดเพียงคำตอบเดียว แล้วทำเครื่องหมาย 6 ลงในกระดาษคำตอบ (10 คะแนน)   
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                              เริ่มต้นกบั Photoshop CS6 

 

 
 

     5. เมนูคำสั่งใดใช้สำหรับจัดการกับไฟล์ภาพในลักษณะต่าง ๆ 

ก. File 

ข. Edit 

ค. Image 

ง. Layer 
 

     6. Title Bar คืออะไรในหน้าต่างของโปรแกรม Adobe Photoshop CS6 

ก. กล่องเครื่องมือ 

ข. แถบชื่อโปรแกรม 

ค. พ้ืนทีก่ารทำงาน 

ง. คุณสมบัติของเครื่องมือ 
 

     7. พาเล็ต (Palette) มีหน้าที่ทำอะไร 

 ก. เป็นส่วนที่แสดงคุณสมบัติเกี่ยวกับภาพ 

 ข. เป็นส่วนที่แสดงชื่อไฟล์ภาพที่เปิดใช้งานอยู่ 

 ค. ใช้สำหรับจัดการกับภาพ โดยแยกออกเป็นหมวดหมู่ 

 ง. เป็นส่วนที่ใช้ในการสร้างงานกราฟิก โดยการเปิดไฟล์ภาพเพ่ือแก้ไขบนพื้นที่ใช้งาน 

 

     8. ถ้านักเรียนต้องการบันทึกไฟล์รูปที่สามารถนำกลับมาแก้ไขได้อีกต้องบันทึกด้วยวิธีการใด 

ก. File >> Save as >> เลือก File Format GIF  

ข. File >> Save as >> เลือก File Format PSD  

ค. File >> Save as >> เลือก File Format PDF  

ง. File >> Save as >> เลือก File Format JPEG 
 

     9. การปรับเปลี่ยนขนาดของไฟล์รูปภาพโดยสัดส่วนภาพคงเดิมทำได้ โดยวิธีใด 

ก. Edit --> Resize 

ข. Image --> Image Size 

ค. Image --> Canvas Size  

ง. Layer --> Flatten Image  
 

     10. ข้อใดต่อไปนี้ประกอบไปด้วยเครื่องมือต่าง ๆ ที่ใช้ในการวาด ตกแต่ง และแก้ไขภาพ 

ก. Tool box 

 ข. Menu Bar  

ค. Option Bar  

ง. Application Bar  
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 

กระดาษคำตอบแบบทดสอบก่อนเรียน   
เรื่อง การใช้งานโปรแกรม Adobe Photoshop CS6 

รายวิชาคอมพิวเตอร์ 3 รหัสวิชา ว22282  ชั้นมัธยมศึกษาปีท่ี 2  

เล่มท่ี 1 เรื่อง เริ่มต้นกับ Photoshop CS6 

 

 

 ชื่อ – นามสกุล ................................................................ชั้นมธัยมศึกษาปีที่ 2/...  เลขที่ ........ 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

     เกณฑ์การประเมิน 

 คะแนนระหว่าง  9  - 10   อยู่ในเกณฑ์ ดีมาก 

คะแนนระหว่าง  7  - 8   อยู่ในเกณฑ์ ด ี

คะแนนระหว่าง  5  - 6  อยู่ในเกณฑ์ ปานกลาง 

คะแนนระหว่าง  0 - 4  อยู่ในเกณฑ์ ปรับปรุง 

 

 

ข้อ ก ข ค ง 

1     

2     

3     

4     

5     

6     

7     

8     

9     

10     

 

คะแนนเต็ม 10 

คะแนนได ้  

 

ผลการประเมิน 

�   ดีมาก 

�   ด ี

�   ปานกลาง 

�   ปรับปรุง 

  

(ลงชื่อ).........................................ผู้ประเมิน           

         (นางสุจิตรา  อนันตนมณี) 

วันที่ ........เดือน.....................พ.ศ.......... 
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หลักการทำงานง่าย  ๆ ของ Photoshop คือ การสร้างภาพโดยเริ่มต้นจาก

หน้ากระดาษเปล่า ๆ เหมือนกับจิตรกรที่เขียนภาพลงบนผืนผ้าใบ การหยิบภาพถ่ายขึ้นมา

ปรับแต่งให้ดูดี สมบูรณ์ หรือแหวกแนวในรูปแบบที่ต้องการ ซึ่งขั้นตอนทั้งหมดจะทำงานอยู่

บนหน้าจอของเครื่องคอมพิวเตอร์ ซึ่งแบ่งออกได้หลายด้าน 

 งานตกแต่งภาพถ่าย เป็นการตกแต่งรูปถ่ายเก่า ๆ ให้คมชัดเหมือนใหม่หรือทำการ

แก้ไขความสว่างของรูปถ่ายให้ภาพมีสีสดใสสมจริง  ปรับแต่งภาพถ่ายให้เป็นภาพวาด  

นอกจากนั้นยังสามารถตัดต่อภาพ สร้างภาพล้อเลียน เช่น เอาใบหน้าของคนหนึ่งไปวางบนตัว

คนอีกคนหนึ่ง นำภาพบุคคลไปวางไว้บนฉากหลังฉากอ่ืน เป็นต้น 

งานสิ่งพิมพ์ ไม่ว่าจะเป็นหนังสือ นิตยสาร โฆษณา เรียกได้ว่าเกือบทุกงานที่ต้องใช้

รูป สามารถใช้  Photoshop รังสรรค์ภาพให้เป็นไปตามไอเดียที่เราวางแผนไว้ได้งานเว็บไซต์

บนอินเทอร์เน็ต ใช้สร้างภาพเพ่ือตกแต่งเว็บไซต์  ไม่ว่าจะเป็นแบ็คกราวนด์ ปุ่มตอบโต้                

แถบหัวเรื่อง ตลอดจนภาพประกอบต่าง ๆ นอกจากนั้นยังสามารถออกแบบหน้าเว็บด้วย  

Photoshop ได ้

งานออกแบบทางกราฟิ ก  ใช้  Photoshop ช่ วย ในการสร้ างภ าพสามมิ ติ                    

การออกแบบปกหนังสือและผลิตภัณฑ์ การออกแบบการ์ดอวยพร เป็นต้น 

 

 

 

 

 

 

    บตัรเนื้อหา  

เร่ิมต้นกับ Photoshop CS6 
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หน้าจอของโปรแกรม  Photoshop 

 

เมื่อเราเริ่มต้นใช้งานโปรแกรม หน้าจอแรกที่พบจะประกอบด้วยส่วนประกอบต่าง ๆ 

ซึ่งมีหน้าที่การใช้งานที่แตกต่างกันออกไป เราจึงต้องทำความเข้าใจกับส่วนประกอบต่าง ๆ 

ของหน้าที่จอปรากฏคร่าว ๆ ดังต่อไปนี้ คือ 
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คำสั่งใน แถบเมนู (Menu Bar) มีทั้งหมด 11 คำสั่ง ดงัตอ่ไปนี้คอื 

File ทำงานเก่ียวกับไฟล์ภาพ เช่น การเปิดไฟล์ (Open) และปิดไฟล์ (Close) 

Edit ปรับแต่งภาพในรูปแบบต่าง ๆ เช่น การเติมสี (Fill) รวมไปถึงการกำหนดคุณสมบัติ 

ที่มีผลต่อการปรับแต่งภาพ เช่น กำหนดลักษณะพู่กัน (Define Brush…) 

Image การปรับแต่งทีม่ีผลต่อภาพทั้งภาพ เช่น การปรับขนาดภาพ การปรับโหมดสี 

Layer  ปรับแต่งภาพในแต่ละเลเยอร์และสร้างความสัมพันธ์ระหว่างเลเยอร์ 

Type จัดการกับรูปแบบตัวอักษร และการจัดวางข้อความต่าง ๆ 

Select จัดการกับพ้ืนที่ภาพที่เลือกไว้ มักใช้ร่วมกับกล่องเครื่องมือ 

Filter ปรับแต่งภาพอัตโนมัติด้วยคำสั่งสำเร็จรูป เช่น การสร้างภาพสีน้ำ 

3D ตกแต่งภาพกราฟิก 3 มิต ิ

View  กำหนดมุมมองการแสดงภาพในรูปแบบต่าง ๆ เช่น การซูมดูภาพใกล้ๆ 

Window จัดการหน้าต่างแต่ละหน้าต่างที่ปรากฏบนหน้าจอของโปรแกรม เพ่ือช่วยให้ทำงานได้

สะดวกขึ้น 

Help รวบรวมวิธีการใช้งานและคำแนะนำเกีย่วกับโปรแกรม Photoshop CS6 
 

  

แถบเมนูคำสั่ง 
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กล่องเครื่องมือ (Toolbox) เป็นส่วนที่ เก็บรวบรวมเครื่องมือที่ ใช้ ในการสร้าง                   

การปรับแต่งและการแก้ไขภาพ มีไอคอนให้สามารถเรียกใช้งานได้ง่ายและรวดเร็ว โดยเมื่อเปิด

โปรแกรมขึ้นมา ส่วนของกล่องเครื่องมือจะเป็นไอคอนหนึ่งแถวที่ถูกจัดเก็บอยู่ในกรอบจัดเก็บ 

(Dock) ทางซ้ายมือ เราสามารถคลิกเมาส์แล้วลากไปวางในตำแหน่งใดก็ได้บนหน้าจอ โดยจะ

แบ่งได้ดังต่อไปนี้ 

 

กล่องเคร่ืองมือ 

 

   เมื่อเราเปิดโปรแกรมขึ้นมา

ใช้ ง า น  ไอ ค อ น ใน ก ล่ อ ง

เครื่องมือจะแสดงเป็นแถว

เดียวตามแนวตั้งของหน้าจอ  

เราสามารถเปลี่ยนรูปแบบ

ไอคอนในกล่องเครื่ อ งมื อ        

ให้แสดงเป็นสองแถวเหมือน

เวอร์ชันก่อนได้จากปุ่มลูกศร    

 และหากต้องการเปลี่ยน

ไอคอนกลับ เป็ นหนึ่ งแถว

เหมือนเดิมให้คลิกที่ปุ่มลูกศร       

 อีกครั้ง 

  

คลกิเมาส์ที่ปุ่มลูกศรเพื่อแสดงไอคอนเครื่องมือเป็นแบบแถวเดียวหรอื 2 เมตร 

เครื่องมือที่กำลังถูกเลือกใช้งาน 

ไอคอนที่มีรูป  แสดงว่ามีเครื่องมืออื่น ๆ ซ่อนอยู ่

คลิกเม้าส์ค้างไว้บนไอคอนนั้น ๆ (หรือคลิกปุ่มเมาส์ขวา) 

คีย์ลัดสำหรับใช้

เรียกเครือ่งมือ

กลุ่มนี้ 
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เมื่อต้องการให้ออปชันบาร์กลับมา ยึดติดกับเมนูเหมือนเดิม ก็สามารถทำได้โดยการคลิกที่

บริเวณหัวของแถบอีกครั้ง แล้วลากออปชันบาร์มาปล่อยไว้ใต้เมนูบาร์ 

 

 

แถบกำหนดรูปแบบของเครื่องมือ 

 

แถบกำหนดรูปแบบของเครื่องมือ (Option bar) คือ แถบตัวเลือกสำหรับกำหนดค่า              

การทำงานของเครื่องมือในกล่องเครื่องมือที่เรากำลังใช้งานอยู่ โดยเมื่อเราคลิกเมาส์ที่เครื่องมือ                   

ใน  Toolbox ที่แถบนี้ก็จะแสดงตัวเลือกให้เรียกใช้งาน เพ่ือช่วยให้การทำงานสะดวกยิ่งข้ึน 

นอกจากนั้นยังสามารถเคลื่อนย้ายออปชันบาร์ไปวางยังตำแหน่งอ่ืน ๆ ได้ เพ่ือให้สะดวก

ในการใช้งานตามท่ีเราถนัด 
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เราสามารถเลือกการแสดงคุณสมบัติของภาพได้หลายรูปแบบโดยคลิกท่ีแถบแสดง 

 

 

พื้นที่การทำงาน 

 

แถบด้ านบนและด้ านล่ างของพ้ืนที่ การทำงาน  (Document window) จะบอก

รายละเอียดของไฟล์ที่เรากำลังทำงานอยู่ และเมื่อวางเมาส์ไว้ที่แถบดังกล่าว จะปรากฏรายละเอียด

ของไฟล์แบบเต็ม ๆ โดยจะมีท่ีอยู่ของไฟล์ภาพแสดงขึ้นมาด้วย ดงัรูป 

 

Adobe Drive  การเกบ็ภาพบนเว็บ 

Document Sizes ขนาดของภาพ 

Document Profile รายละเอียดภาพ 

Document Dimensions ขนาดกว้างยาวของภาพ 

Measurement Scale หน่วยวัดที่ใช้งาน 

Scratch Sizes  ขนาดของ Scratch 

Efficiency  ประสิทธิภาพ 

Timing   เวลา 

Current Tool  เครือ่งมือที่กำลังใช้งานอยู่ 

32 – bit Exposure ระบบการทำงาน 32 บิต 

Save Progress  การบันทึกความคืบหน้า 
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 พาเนล (Panel) เป็นหน้าต่างย่อยที่รวบรวมคุณสมบัติการทำงานของเครื่องมือต่าง ๆ 

ให้เราเลือกปรับแต่งการใช้งานได้ง่าย ๆ โดยไม่ต้องเปิดหาที่แถบคำสั่งอีกต่อไป ใน Photoshop 

CS6 จะมีพาเนลทั้งหมด 26 รูปแบบด้วยกัน ซึ่งจะอธิบายถึงรายละเอียดในบทของการใช้

เครื่องมือเหล่านั้นอีกครั้ง 

 

 

พาเนลควบคุมการทำงาน 

 

การเปิด/ปิดพาเนล 

เราสามารถเปิด/ปิดพาเนลได้จากคำสั่ง Window แล้วเลือกชื่อพาเนลที่เราต้องการ

แสดงหรือไม่แสดง และจะเห็นว่าถ้าพาเนลไหนถูกเปิดอยู่ จะมีเครือ่งหมายถูกหน้าชื่อพาเนลนั้น 
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พาเนลที่ถูกเปิดขึ้นจะถูกเปิดอยู่ในกรอบที่จัดเก็บ ถ้าหากไม่ต้องการแสดงพาเนลใด                   

ให้คลิกเลือกพาเนลนั้นอีกครั้งเพ่ือเอาเครื่องหมายถูกออก หรืออาจจะคลิกเมาส์ที่ปุ่ม เพ่ือปิด

พาเนลก็ได้ แต่ถ้าต้องการลดย่อขนาดก็ให้คลิกเมาส์ปุ่ม ทำให้ไม่เกะกะพ้ืนที่การทำงานบน

หน้าจอโปรแกรม 

แต่ละพาเนลจะมีเมนูคำสั่งของตัวเองเพ่ือควบคุมการทำงาน สามารถเรียกดูเมนูในแต่

ละพาเนลได้โดยคลิกที่ และคลิกเลือกคำสั่งที่ต้องการ 

 

ยุบพาเนลเป็นไอคอน 

เราสามารถยุบพาเนลที่อยู่ภายในพ้ืนที่จัดเก็บให้กลายเป็นไอคอน เพ่ือประหยัดพ้ืนที่

การใช้งานได้ และเมื่อเรายุบเป็นไอคอนแล้วหากต้องใช้งานพาเนลใดก็เพียงแค่คลิกเมาส์                  

ที่ไอคอนของพาเนลนั้น หน้าต่างของพาเนลก็จะถูกเปิดขึ้นมาใช้งานได้ทันที 
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เปล่ียนตำแหน่งกลุ่มพาเนล 

 

 

 

 

 

 
 

 

 

 

 

 

การเคลื่อนย้ายกลุ่มพาเนล/พาเนล 

เราสามารถเคลื่อนย้ายเพ่ือเปลี่ยนตำแหน่งของกลุ่มพาเนล และพาเนลภายในกรอบ

พ้ืนที่จัดเก็บ โดยการเลื่อนตำแหน่งขึ้น/ลง หรือนำพาเนลเข้า/ออกจากกรอบจัดเก็บได้                 

โดยการคลิกเมาส์แล้วลากบริเวณแถบกำหนดรูปแบบของเครื่องมือ (Title bar) เพ่ือย้าย

ตำแหน่งทั้งกลุ่มพาเนล หรือคลิกท่ีแต่ละแทบ็ (Tab) ของพาเนลเพ่ือย้ายเฉพาะพาเนลที่ต้องการ 

 

การเคลื่อนย้ายกลุ่มพาเนล 

เป็นการเคลื่อนย้ายกลุ่มพาเนลทั้งกลุ่มที่อยู่ในหน้าต่างเดียวกัน โดยการคลิกเมาส์ค้างไว้

ที่แถบหัวข้อพาเนล (Title bar) แล้วลากทั้งกลุ่มพาเนลไปยังตำแหน่งที่ต้องการ ดังตัวอย่างเรา

จะย้ายกลุ่มของพาเนล Layers ทั้งกลุ่มไปไว้ในตำแหน่งต่าง ๆ ได ้

 

1. ลากเมาส์ที่แถบหัวขอ้พาเพล Adjustments ไปวางด้านบนพาเนล 

Color ปล่อยเมาส์ในตำแหน่งปรากฎแถบสีฟ้า  

2. กลุ่มพาเนล Adjustments ทีอ่ยู่ด้านล่างจะถูกเปลี่ยนตำแหน่งอยู่บนพาเนล Color 
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ย้ายเขา้/ออกใน Dock 

 

 

 

 
 

 

 

 

 

 

 

 

การเคลื่อนย้ายพาเนล 

เป็นการเคลื่อนย้ายพาเนลที่เราต้องการเพียงพาเนลเดียว โดยการคลิกเมาส์ค้างไว้ที่

แท็บ (Tab) ของพาเนลนั้น แล้วลากไปยังตำแหน่งที่ต้องการ 
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การเปิดไฟล์ภาพด้วยคำสั่ง  Open 

 
ในการสร้างชิ้นงานเราจะต้องเปิดไฟล์ภาพจากแหล่งข้อมูลต่าง ๆ เช่น จากแผ่นซีดี  

จากกล้องดิจิตอล หรือไฟล์ภาพในเครื่องของเรา ซึ่งมีข้ันตอนการเปิดไฟล์ภาพ ดังต่อไปนี้ 

 

 

1. เลือกคำสั่ง File>Open จากเมนูคำสั่งของโปรแกรม หรือกด <Ctrl+O> ที่คีย์บอร์ด 

เพ่ือเปิดไฟล์ 

2. จะปรากฏหน้าต่าง Open เลือกตำแหน่งที่เก็บไฟล์ภาพในช่อง Look in แล้วให้

เลือกไฟล์ภาพที่ต้องการ 

3. จากนั้นคลิกปุ่ม Open เพ่ือเปิดไฟล์ภาพขึ้นมาในหน้าจอโปรแกรม Photoshop 

(ถ้าต้องการเปิดหลายไฟล์ ให้กดแป้น <Ctrl> ค้างไว้ขณะที่เลือกไฟล์ที่ต้องการ) 

 

 ลักษณะการเปิดไฟล์ยังมีอีก 3 ลักษณะ ที่จะช่วยเราให้สามารถเปิดไฟล์ได้อย่างรวดเร็ว  

และรักษาคุณสมบัติของไฟล์ไว้ได้คือ 

 f คำสั่ ง Open As… ใช้สำหรับการเปิดไฟล์ภาพที่ต้องการระบุชนิดของไฟล์               

อย่างเจาะจง เนื่องจากไฟล์นั้น ๆ ไม่ตรงกับประเภทของไฟล์ใด ๆ โดยโปรแกรมจะช่วยเลือก

เฉพาะไฟล์ประเภทนั้นให้เราเลือกเปิด 

 f คำสั่ ง Open as Smart Object… เป็ นคำสั่ งที่ ใช้ เปิ ดไฟล์ภาพ  ซึ่ งจะรักษา

คุณสมบัติเดิมของภาพที่เป็นเวกเตอร์หรือบิตแมพเอาไว้ 

 f คำสั่ง Open Recent  เป็นคำสั่งที่ใช้เปิดไฟล์ภาพที่เคยเปิดมาก่อนหน้านี้แล้ว                   

ซึ่งสามารถเปิดย้อนกลับไปได้ถึง 10 ไฟล์ 
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การเปิดไฟล์ภาพด้วย Adobe Bridge และ Mini Bridge 

 
Adobe Bridge เป็นฟังก์ชันที่ช่วยให้เราเลือกเปิดไฟล์ใช้งานได้ง่ายยิ่งขึ้น ภายใน

หน้าจอจะแสดงภาพตัวอย่างของไฟล์ทั้งหมด และสามารถค้นหาไฟล์จากไดรฟ์ต่าง ๆ ได้                 

โดยเลือกคำสั่ง File > Browse in Bridge ในการเปิดหน้าต่างการใช้งาน 

 

 พาเนล Mini Bridge เป็นการเปิดไฟล์ภาพลักษณะเดียวกับ Adobe Bridge แต่มีขนาด

เล็กกว่าการใช้งานทำได้รวดเร็วกว่า แต่มีรายละเอียดที่น้อยกว่า เหมาะสำหรับการค้นหาภาพมา

ใช้ งานที่ ไม่ต้องดู รายละเอียดมากนัก  โดยเลื อกคำสั่ ง File > Browse in Mini Bridge                     

ในการเปิดหน้าต่างการใช้งาน หรือคลิกที่ปุ่ม Launch Bridge ในพาเนล Mini Bridge ที่อยู่

ด้านล่างของหน้าจอโปรแกรม 
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 1. เลือกคำสั่ง  File > New  หรือกดแป้น  <Ctrl + N>  ที่คีย์บอร์ดเพ่ือสร้างไฟล์ใหม่ 

 2. จากนั้นจะปรากฏหน้าต่าง New ขึ้นมา ให้เราพิมพ์ชื่อไฟล์ใหม่ลงในช่อง Name (สามารถ

ตั้งชื่อได้ทั้งภาษาไทยและอังกฤษ) จากนั้นให้กำหนดรูปแบบหน้ากระดาษ ดังนี้ 

 Width   กำหนดความกว้างของภาพ โดยช่องด้านหลังเป็นการกำหนด

หน่วยวัดของความกว้าง ซึ่งมีหน่วยวัดหลายแบบ เช่น pixel  

เป็นหน่วยวัดพ้ืนฐานบนคอมพิวเตอร์ หรือ inches (นิ้ว) และ

หน่วยวัดอ่ืน ๆ 

 Height   กำหนดความสูงของภาพ โดยหน่วยวัดจะเป็นไปตามที่เรากำหนด

ในความกว้าง 

 Resolution   หนดความละเอียดของภาพ โดยงานกราฟิกสำหรับเว็บควรจะ

กำหนดค่าเท่ากับ 72 pixels/inch และงานด้านสิ่งพิมพ์ต้องใช้  

200 – 300  pixels/inch 

 

การสร้างไฟล์ใหม่ด้วยคำสั่ง New 

 

          เมื่อเราได้จัดเตรียมภาพที่จะนำมาใช้ และได้ร่างชิ้นงานที่จะสร้างเรียบร้อยแล้ว                   

ในหัวข้อนี้จะเป็นการสร้างไฟล์ชิ้นงานใหม่ โดยเริ่มต้นด้วยการกำหนดขนาดและความละเอียด

ของชิ้นงานที่จะนำไปใช้งาน ซึ่งเราควรกำหนดให้เหมาะกับลักษณะงานที่จะนำไปใช้ มีขั้นตอน

ดังนี้ 
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 Color Mode   กำหนดโหมดสีของภาพ เช่น โหมด RGB จะใช้งานกราฟิกสำหรับ

เว็บและภาพเคลื่อนไหว แต่ถ้าเป็นโหมด CMYK จะเหมาะสำหรับ

งานสิ่งพิมพ์ โดยจำนวนบิตด้านหลัง คือ จำนวนของสีที่ ใช้               

(ยิ่งมีค่ามาก สีจะยิ่งเหมือนจริงขึ้น) แต่ไฟล์ภาพที่ได้ก็จะมีขนาด

ใหญ่ขึ้น 

 Background Contents  กำหนดพ้ืนหลังของภาพ ซึ่งสามารถกำหนดเป็นสีขาว (White)    

สีพื้นหลัง (Background Color) และโปร่งใส (Transparent) 

 3.  คลิกปุ่ม    เพ่ือตกลงการสร้างไฟล์ใหม่ตามที่เรากำหนด 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

กำหนดขนาดไฟล์ภาพตามคำมาตรฐาน 

งานกราฟิกที่ต้องทำบ่อย ๆ ก็จะมีค่าขนาดของไฟล์งานมาตรฐานที่กำหนดไว้แล้ว                 

ใน Photoshop ให้เราเรียกใช้ได้โดยไม่ต้องมากำหนดเอง โดยที่หน้าต่าง Preset จะมีรูปแบบ

ของกระดาษที่ใช้งานบ่อยให้เลือก จากนั้นในช่อง Size  จะมีขนาดกระดาษของรูปแบบที่เลือก  

และรายละเอียดของชิ้นงานให้เราเรียกใช้ได้เลย โดยไม่ต้องกำหนดค่าต่าง ๆ เอง โดยมีรูปแบบ

ต่าง ๆ ดังนี้ 

-  U.S. Paper ขนาดกระดาษที่ใช้ในสหรัฐอเมริกา   เช่น Letter ; Legal.  

         Tabloid 

-  International Paper ขนาดกระดาษสิ่งพิมพ์มาตรฐาน       เช่น A4, A3, B5 

-  Photo ขนาดกระดาษอัดภาพถ่าย   เช่น 2x3, 4x6, 5x7 

-  Web ขนาดของหน้าจอสำหรับสร้างเว็บไซต์   เช่น 640x480, 800x600 

-  Mobile & Devices ขนาดภาพบนหน้าจอโทรศัพท์มือถือ   เช่น 176x208, 208x320,  

         352x416 

-  Film & Video ขนาดของภาพในงานวิดีโอ   เช่น NTSC DV 720x480 
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องค์ประกอบท่ีมีผลกับไฟล์ภาพ 

 1. ขนาดความกว้างและความยาว ถ้าภาพมีความกว้างและความยาวมาก ขนาดของ

ไฟล์ก็จะใหญ่มาก ดังนั้นควรจะกำหนดให้ขนาดของภาพมีขนาดตามที่ต้องใช้งานจริง                       

เพ่ือช่วยลดขนาดไฟล์ 

 2. ความละเอียด (Resolution) ถ้าความละเอียดของภาพมาก ขนาดไฟล์ภาพก็จะ

มาก ถึงแม้คุณภาพของภาพสูงแต่เครื่องคอมพิวเตอร์จะทำงานช้า ดังนั้นเราควรกำหนด  

Resolution ตามการใช้งาน เช่น 

  fภาพที่นำเสนอบนเว็บเพจและพรีเซนเตชัน ควรใช้ 72 DPI (Dots per inch) 

  fภาพที่พิมพ์ออกทางเครื่องพิมพ์เลเซอร์ ควรใช้ 200 DPI 

  f สิ่งพิมพ์ต่าง ๆ ที่ต้องเข้าพิมพ์ในโรงพิมพ์ เช่น ปกนิตยสารควรใช้ 300 DPI 

 3.  โหมดสีของภาพ  จะมีผลต่อขนาดของไฟล์  โดยสามารถเรียงลำดับโหมดสีที่ทำให้

ได้ขนาดไฟล์น้อยไปมาก  ได้ดังนี้  Bitmap, Grayscale, RGB, CMYK, Lab color 

 
การบันทึกไฟล์งานรูปแบบต่าง ๆ 

 

 เมื่อสร้างชิ้นงานเสร็จเรียบร้อยแล้ว เราจะทำการบันทึกไฟล์งานได้โดยเลือกคำสั่ง File  

ที่เมนูบาร์ และเลือกรูปแบบการบันทึกไฟล์ ซึ่งรูปแบบหลัก ๆ ที่ใช้งานบ่อยมี 3 รูปแบบด้วยกัน

คือ Save, Save As และ Save for Web  ดังนี้ 
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fFile>Save   การบันทึกงานในไฟล์เดมิที่กำลังเปิดแก้ไขอยู่ 

fFile>Save As   การบันทึกงานเดิมในชื่อใหม่ หรือบันทึกให้อยู่ในรูปฟอร์แมต

ใหม ่

fFile>Check in   การทำงานและแก้ไขไฟล์ภาพร่วมกันผ่านเครือข่ายที่จัดการโดย

โปรแกรม Version Cue Workspace ซึ่ งจะตรวจสอบการ

บันทึกไฟล์งานแต่ละครั้งของผู้ที่เข้ามาแก้ไข 

fFile>Save for Web   การบันทึกไฟล์เพ่ือให้ได้ภาพที่เหมาะสำหรับการใช้งานบน

เว็บไซต์ 

fFile>Revert   ย้อนหลังคำสั่งไป 1 ขั้นตอน 
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 Background Save เป็นความสามารถในการบันทึกไฟล์งาน ในขณะที่เรากำลังทำงาน

ในไฟล์งานอีกตัวโดยไม่ต้องรอให้บันทึกเสร็จสมบูรณ์ ซ่ึงสะดวกและรวดเร็วในการทำงานกับไฟล์

งานที่มีขนาดใหญ่ ใช้เวลาในการบันทึกนาน 

 

Auto Save  เป็นความสามารถในการบันทึกไฟล์งานอัตโนมัติ ตามเวลาที่เราได้

กำหนดไว้ เช่น ตั้งค่าให้บันทึกไฟล์ทุก ๆ 10 นาที ซึ่งช่วยเราได้ในกรณีที่เครื่องคอมพิวเตอร์มี

ปั ญ ห า  ห รื อ ไฟ ดั บ ข ณ ะที่ ก ำลั งท ำ งาน อยู่ แ ล้ ว ยั ง ไม่ ได้ บั น ทึ ก  โด ย เลื อ ก ค ำสั่ ง  

Edit>Preferences>File Handling เพ่ือเปิดหน้าต่างการตั้งค่าการบันทึกไฟล์ 
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 เริ่มแรกให้เรากำหนดขนาดของแผ่นโปสการ์ดที่เป็นชิ้นงานของเรา ดังนี้ 

 

ทดลองสร้างชิ้นงานแรก 

 

 ในตัวอย่างนี้จะสร้างแผ่นโปสการ์ดอย่างง่าย ๆ จากไฟล์ภาพที่เราเตรียมไว้ ได้แก่          

ภาพพ้ืนหลัง (BGPostcard.jpg) และภาพพ้ืนหลังสำหรับเขียนข้อความ (BGText.png) โดยนำ

ภาพที่เตรียมไว้มาจัดวางให้สวยงาม และจะนำเสนอเป็นหลักการทำงานเบื้องต้นของโปรแกรม  

Photoshop ดังนี้ 

ขั้นตอนที่ 1  กำหนดขนาดของชิ้นงาน 

ขั้นตอนที่ 2  เปิดไฟล์ภาพที่ต้องการนำมาตกแต่ง 

ขั้นตอนที่ 3  ตกแต่งภาพโดยการจัดงานและเพ่ิมข้อความ 

ขั้นตอนที่ 4  บันทึกไฟล์ภาพ 

ขั้นตอนที่ 5  ออกจากการทำงานของโปรแกรม 

 

ขั้นตอนที่ 1  กำหนดขนาดของช้ินงาน 
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 1. เลือกคำสั่ง  File>New เพ่ือเปิดหน้ากระดาษใหม่ 

 2. จะปรากฏหน้าต่าง New จากนั้นตั้งชื่อไฟล์ว่า MyPostCard กำหนดขนาดและรายละเอียด

ของหน้ากระดาษโปสการ์ดของเรา ในที่นี้กำหนด 

 f ขนาดความกว้างและความยาวเท่ากับ 4 x 6 นิ้ว (inches) 

 f ความละเอียด (Resolution) 300 พิกเซล/นิ้ว (pixels/inch) 

 f โหมดสี (Color Mode) เป็น RGB Color 8 บิต (bit) 

 f พ้ืนหลังของภาพ (Background Contents) เป็นสีขาว (White) 

    แล้วคลิกเมาส์ปุ่ม  เพ่ือตกลง 
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เปิดไฟล์ภาพที่อยู่ในเครื่องคอมพิวเตอร์ของเราขึ้นมาตกแต่งในหน้ากระดาษใหม่ที่เปิดอยู่   

จากหน้าต่าง  Mini Bridge (เป็นหน้าต่างที่ช่วยเปิดหาไฟล์ภาพจำนวนมากได้อย่างรวดเร็วหรือจะใช้

คำสั่ง  File>Open ก็ได้) ดังนี้ 

 

 

 

 

 

 

 

 

 

1. เลือกคำสั่ง File>Browse in Mini Bridge เพ่ือเปิดหน้าต่างย่อยแสดงภาพ 

 2. จะปรากฏหน้าต่าง Mini Bridge ภายในโปรแกรม Photoshop จากนั้นคลิกเลือกโฟลเดอร์

ที่เก็บภาพในเครื่องของเรา 

 3. ดับเบิลคลิกภาพที่จะนำมาตกแต่งใน Photoshop ตัวอย่างนี้ เราจะนำภาพมาตกแต่ง

ทั้งหมด 2 ภาพ ชื่อภาพพ้ืนหลัง (BGPostcard.jpg) และภาพพ้ืนหลังข้อความ (BGText.png) 

 

ขั้นตอนที่ 2  เปิดไฟล์ภาพที่ต้องการนำมาตกแต่ง 
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 

 

ให้นำภาพที่เราเปิดขึ้นมาทั้งหมดจากขั้นตอนที่ผ่านมา นำมาจัดวางในหน้ากระดาษเปล่า ๆ             

ที่ยงัเปิดไว้อยู่จากขั้นตอนที่ 1 แล้วทำการจัดวางให้เหมาะสมสวยงาม ดังขั้นตอนต่อไปนี้ 
 

 
 

 1. ใช้          ลากภาพพ้ืนหลังมาวางไว้ยังหน้ากระดาษเปล่าที่เรากำหนดขนาดไว้แล้วจาก

ขั้นตอนที่ 1 

 2. ใช้    ลากภาพพ้ืนหลังข้อความมาวางซ้อนอยู่บนภาพรูปภาพ 

3. ใช้    คลิกเมาส์ลงบนพ้ืนหลังที่สร้างไว้สำหรับวางข้อความและพิมพ์ข้อความที่ต้องการ

ลงไป ก็จะได้โปสการ์ดที่สร้างข้ึนด้วยภาพถ่ายของเราเอง 

ขั้นตอนที่ 3  ตกแต่งภาพโดยการจัดวางและเพิ่มข้อความ 
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 
 

 หลังจากสร้างชิ้นงานเสร็จแล้ว เราสามารถบันทึกไฟล์ได้หลายรูปแบบ ดังนี้ 

 

 
 1. เลือกคำสั่ ง File ที่ เมนูบาร์และเลือกรูปแบบการบันทึกไฟล์ เป็น  Save As เพ่ือเป็น                 

การบันทึกงานเดิมเป็นชื่อใหม่เพ่ือที่ไฟล์งานจะไม่ซ้อนทับกับไฟล์เดิม 

 2. ในช่อง Save In : ให้กำหนดตำแหน่งของโฟล์เดอร์เพ่ือใช้เก็บไฟล์ที่จะบันทึกนี้ 

 3. ในช่อง File name : พิมพ์ชื่อไฟล์ที่จะบันทึกลงไป 

 4. ในช่อง Format : เลือกชนิดของไฟล์ที่จะนำไปใช้งาน ในที่นี้จะแนะนำให้บันทึกเป็น PSD  

คือ ให้โปรแกรมบันทึกค่าสี เทคนิคพิเศษ และรายละเอียดในการซ้อนวางภาพทั้งหมด เพ่ือเราจะ

สามารถเปิดไฟล์นี้มาแก้ไขได้อีก สำหรับการบันทึกชิ้นงานเพ่ือนำไปส่งโรงพิมพ์จะใช้ฟอร์แมต TIFF  

ส่วนการนำไปสร้างพรีเซนเตชัน แล้วสร้างเว็บไซต์ จะใช้ฟอร์แมต  JPEG, GIF  และ  PNG 

 5.  ในส่วนของ Save Options  เป็นการกำหนดคุณสมบัติต่าง ๆ ให้สัมพันธ์กับฟอร์แมตที่เรา

เลือกในตัวอย่างบันทึกเป็น  PSD  ซึ่งโปรแกรมจะกำหนดให้โดยอัตโนมัติ (ส่วนฟอร์แมตอ่ืนจะ

กำหนดค่าแตกต่างกันไปตามคุณสมบัติของแต่ละฟอร์แมต) 

 6. คลิกเมาส์ที่ปุ่ม   เพ่ือทำการบันทึกไฟล์ 

 

ขั้นตอนที่ 4 การบันทกึไฟล์ (Save) 
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 

 

 
 สุดท้าย เมื่อต้องการออกจากหน้าต่างไฟล์ภาพและโปรแกรมการทำงานสามารถทำได้                 

โดยคลิกที่ปุ่ม   

 

 
  

 1.  ที่หน้าต่างแสดงไฟล์ภาพ ให้คลิกเมาส์ที่ปุ่ม     ไฟล์จะถูกปิดทันที 

 2.  ที่หน้าต่างโปรแกรม ให้คลิกเมาส์ที่ปุ่ม      หน้าต่างโปรแกรมจะถูกปิดทันที 

 

 

 

 

 

 

 

 

 

 

 

ขั้นตอนที่ 5  ออกจากการทำงานของโปรแกรม 
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. โปรแกรม Photoshop ใช้สร้างงานกราฟิกอะไรได้บ้าง  

    ................................................................................................................................................... 

    ............................................................................................................................. ...................... 

2. Menu Bar (เมนูบาร์) คือ ................................................................................. .......................... 

   ................................................................................................ ..................................................... 

   ......................................................................... ............................................................................ 

3. Option Bar (ออปชั่นบาร์) คือ .................................................................................................. 

   ..................................................................................................................................................... 

   ............................................................................................................................... ...................... 

4. Panel (พาเนล) คือ............................................................................................................ ......... 

   ................................................................................ ..................................................................... 

   .......................................................................................... ........................................................... 

5. หากเราต้องการสร้างไฟล์ภาพใหม่ เราจะต้องสร้างไฟล์ใหม่โดย................................................. 

   ..................................................................................... ................................................................ 

6. หากต้องการให้พ้ืนหลังของไฟล์งานที่เราสร้างใหม่ โปร่งแสง จะต้องทำอย่างไร 

   ................................................................................................................. .................................... 

   ...................................................................................... ............................................................... 

7. ถ้าต้องการบันทึกภาพเพ่ือกลับมาแก้ไขใหม่ หรือยังตกแต่งภาพไม่เสร็จต้องบันทึกเป็นนามสกุล 

   อะไร 

   ............................................................................... ...................................................................... 

8. ถ้าต้องการบันทึกภาพเพ่ือนำภาพไปใช้ในงานพิมพ์ หรือนำไปใช้ในโปรแกรมอ่ืน ๆ เราจะต้อง 

   บันทึกเป็นนามสกุลอะไร 

   ........................................................................ ............................................................................. 

9. ในการนำภาพไปใช้ในเว็บเพจเราจะต้องบันทึกเป็นนามสกุล.GIF เพราะเหตุใด 

   ......................................................................................................... ............................................ 

10. ให้อธิบายข้อดีของการบันทึกภาพ เป็นรูปแบบไฟล์* . PSD 

   ..................................................................................................................................................... 

 

 

 

 

       บัตรกจิกรรมที่ 1 

คำชี้แจง  ให้นักเรียนตอบคำถามต่อไปนี้ให้ถูกต้อง  (10 คะแนน)   
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 

 

 

 

1. ให้นักเรียนฝึกสร้างไฟล์ใหม่ ขนาด 800 pixel สูง 600 pixel  

2. ให้นักเรียนฝึกบันทึกไฟล์ภาพในรูปแบบ JPEG ตามดว้ยชื่อของนักเรียนและตามด้วยเลขที่

ห้อง (ตัวอย่าง : Photoshop–สุจิตรา–32)  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

     บัตรกิจกรรมที่ 2 

คำชี้แจง   ให้นักเรียนปฏิบัติตามคำสั่งต่อไปนี้ (20 คะแนน)  

 

                 

 

 

 

รูปภาพนักเรียนตอนปฏิบัติงาน 

 

 

 

รูปภาพนักเรียนตอนปฏิบัตงิาน 

 

 

 

 

รูปภาพนักเรียนตอนปฏิบัติงาน 

 

 

 

รูปภาพนักเรียนตอนปฏิบัติงาน 
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 

 

 

 

 

 
 

 

     1. พาเล็ต (Palette) มีหน้าที่ทำอะไร 

 ก. เป็นส่วนที่แสดงคุณสมบัติเกี่ยวกับภาพ 

 ข. เป็นส่วนที่แสดงชื่อไฟล์ภาพที่เปิดใช้งานอยู่ 

 ค. ใช้สำหรับจัดการกับภาพ โดยแยกออกเป็นหมวดหมู่ 

 ง. เป็นส่วนที่ใช้ในการสร้างงานกราฟิก โดยการเปิดไฟล์ภาพเพ่ือแก้ไขบนพื้นที่ใช้งาน 

 

2. ความสำคญัของงานกราฟิกคืออะไร 

ก. เพ่ือช่วยในการสร้างเว็บไซต ์

ข. เพ่ือช่วยในการแตกแต่งภาพ 

ค. เพ่ือช่วยให้คุณภาพของงานดีขึ้น 

ง. ถูกทุกข้อ 
 

     3. ข้อใดต่อไปนี้ประกอบไปด้วยเครื่องมือต่าง ๆ ที่ใช้ในการวาด ตกแต่ง และแก้ไขภาพ 

ก. Tool box 

 ข. Menu Bar  

ค. Option Bar  

ง. Application Bar 

 

     4. เมนูคำสั่งใดใช้สำหรับจัดการกับไฟล์ภาพในลักษณะต่าง ๆ 

ก. File 

ข. Edit 

ค. Image 

ง. Layer 

 

 

  แบบทดสอบหลังเรียน 

เร่ือง การใช้งานโปรแกรม Adobe Photoshop CS6 

รายวิชาคอมพิวเตอร์ 3 รหัสวิชา ว22282  

ชั้นมัธยมศึกษาปีที่ 2  

เล่มที่ 1 เร่ือง เร่ิมต้นกบั Photoshop CS6 

 

 คำชี้แจง  แบบทดสอบแบบปรนัย 4 ตวัเลือก จำนวน 10 ข้อ ให้นักเรียนเลือกคำตอบทีถู่กต้อง 

            ที่สุดเพียงคำตอบเดียว แล้วทำเครื่องหมาย 6 ลงในกระดาษคำตอบ (10 คะแนน)   
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                              เริ่มต้นกบั Photoshop CS6 

 

 
 

     5. Title Bar คืออะไรในหน้าต่างของโปรแกรม Adobe Photoshop CS6 

ก. กล่องเครื่องมือ 

ข. แถบชื่อโปรแกรม 

ค. พ้ืนทีก่ารทำงาน 

ง. คุณสมบัติของเครื่องมือ 
 

 6. โปรแกรม Adobe Photoshop CS6 เป็นโปรแกรมประเภทใด 

ก. โปรแกรมฐานข้อมูล 

ข. โปรแกรมแกลอรี่ภาพ 

ค. โปรแกรมนำเสนอภาพ 

ง. โปรแกรมคอมพิวเตอร์กราฟิก 
 

     7. ถ้านักเรียนต้องการบันทึกไฟล์รูปที่สามารถนำกลับมาแก้ไขได้อีกต้องบันทึกด้วยวิธีการใด 

ก. File >> Save as >> เลือก File Format GIF  

ข. File >> Save as >> เลือก File Format PSD  

ค. File >> Save as >> เลือก File Format PDF  

ง. File >> Save as >> เลือก File Format JPEG 
 

     8. การปรับเปลี่ยนขนาดของไฟล์รูปภาพโดยสัดส่วนภาพคงเดิมทำได้ โดยวิธีใด 

ก. Edit --> Resize 

ข. Image --> Image Size 

ค. Image --> Canvas Size  

ง. Layer --> Flatten Image  
 

9. ข้อใดวิธีเปิดใช้โปรแกรม Adobe Photoshop CS6 

ก. Start -> Run -> Adobe Photoshop CS6 

ข. Start -> Setting -> Adobe Photoshop CS6  

ค. Start -> All Programs -> Adobe Photoshop CS6 

ง. Start -> Control panel -> Adobe Photoshop CS6 
 

10. ข้อใดคือไฟล์ของโปรแกรม Adobe Photoshop CS6 

ก. PDS 

ข. AVI 

ค. ACDC 

ง. MPEG 
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                              เริ่มต้นกบั Photoshop CS6 

 

  

 

กระดาษคำตอบแบบทดสอบหลังเรียน   
เรื่อง การใช้งานโปรแกรม Adobe Photoshop CS6 

รายวิชาคอมพิวเตอร์ 3 รหัสวิชา ว22282  ชั้นมัธยมศึกษาปีท่ี 2  

เล่มท่ี 1 เรื่อง เริ่มต้นกับ Photoshop CS6 

 

 

 ชื่อ – นามสกุล ................................................................ชั้นมธัยมศึกษาปีที่ 2/...  เลขที่ ........ 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

     เกณฑ์การประเมิน 

 คะแนนระหว่าง  9  - 10   อยู่ในเกณฑ์ ดีมาก 

คะแนนระหว่าง  7  - 8   อยู่ในเกณฑ์ ด ี

คะแนนระหว่าง  5  - 6  อยู่ในเกณฑ์ ปานกลาง 

คะแนนระหว่าง  0 - 4  อยู่ในเกณฑ์ ปรับปรุง 

 

 

ข้อ ก ข ค ง 

1     

2     

3     

4     

5     

6     

7     

8     

9     

10     

 

คะแนนเต็ม 10 

คะแนนได ้  

 

ผลการประเมิน 

�   ดีมาก 

�   ด ี

�   ปานกลาง 

�   ปรับปรุง 

  

(ลงชื่อ).........................................ผู้ประเมิน           

         (นางสุจิตรา  อนันตนมณี) 

วันที่ ........เดือน.....................พ.ศ.......... 
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

ภาคผนวก 
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. โปรแกรม Photoshop ใช้สร้างงานกราฟิกอะไรได้บ้าง  

    ................................................................ ................................................................................... 

    ............................................................................................................................. ...................... 

2. Menu Bar (เมนูบาร์) คือ ........................................................................................................... 

   ................................................................................................ ..................................................... 

   ..................................................................................................................................................... 

3. Option Bar (ออปชั่นบาร์) คือ ........................................................... ....................................... 

   ................................................................................ ..................................................................... 

   ............................................................ ......................................................................................... 

4. Panel (พาเนล) คือ.....................................................................................................................  

   ..................................................................................................................................................... 

   ............................................................................................................................. ........................ 

5. หากเราต้องการสร้างไฟล์ภาพใหม่ เราจะต้องสร้างไฟล์ใหม่โดย................................................. 

   ........................................................................................................................... .......................... 

6. หากต้องการให้พ้ืนหลงัของไฟล์งานที่เราสร้างใหม่ โปร่งแสง จะต้องทำอย่างไร 

   ............................................................................................................................. ........................ 

   .............................................................................................................................. ....................... 

7. ถ้าต้องการบันทึกภาพเพ่ือกลับมาแก้ไขใหม่ หรือยังตกแต่งภาพไม่เสร็จต้องบันทึกเป็นนามสกุล 

   อะไร 

   .....................................................................................................................................................  

8. ถ้าต้องการบันทึกภาพเพ่ือนำภาพไปใช้ในงานพิมพ์ หรือนำไปใช้ในโปรแกรมอ่ืน ๆ เรา 

    จะต้องบันทึกเป็นนามสกุลอะไร 

   .....................................................................................................................................................  

9. ในการนำภาพไปใช้ในเว็บเพจเราจะต้องบันทึกเป็นนามสกุล.GIF เพราะเหตุใด 

   ..................................................................................................................................................... 

10. ให้อธิบายข้อดีของการบันทึกภาพ เป็นรูปแบบไฟล์* . PSD 

   ................................................................ ..................................................................................... 

 

 

 

 

       บัตรเฉลยกจิกรรมที ่1 

คำชี้แจง  ให้นักเรียนตอบคำถามต่อไปนี้ให้ถูกต้อง  (10 คะแนน)   

 

                 ปา้ยโฆษณา, ออกแบบเว็บไซต์, โปรสเตอร์ประชาสัมพันธ์งานต่าง ๆ, พ้ืนหลังเอกสารสวย ๆ , 

การด์อวยพร 

เป็นแถบที่ใช้เก็บคำสั่งต่าง ๆ ของโปรแกรม โดยเราสามารถเรยีกใช้คำสั่ง ในแถบคำสั่งได้              

โดย Click mouse ที่แถบคำสั่ง จะปรากฏแถบคำสั่งย่อย ๆ  

เป็นส่วนที่ใช้ปรับปรุงแต่งค่าการทำงานของเครื่องมือต่าง ๆ โดยรายละเอียดในออปชั่นบาร์จะ

เปลี่ยนไปตามเครื่องมือที่เราเลือกจากทูลบ็อกซ์ในขณะนั้น 

ของโปรแกรมใน Photoshop มีพาเนลอยู่เป็นจำนวนมาก เช่น พาเนล Color  

ใช้สำหรับเลือกสี พาเนล Layers 

เป็นวินโดว์ย่อย ๆ ใช้เลือกรายละเอียด หรือคำสั่งควบคุมการทำงานต่าง ๆ 

คลิกที่เมนูไฟล์ เลือก New และกำหนดขนาดของภาพตามที่เราต้องการ 

บันทึกภาพเป็นนามสกุล .PSD 

ตั้งค่า Background Contents เป็น Transparent 

บันทึกภาพเป็นนามสกุล .JPG BMP GIF 

เพราะเป็นไฟล์ที่มีขนาดเล็ก เหมาะสำหรับการอัพโหลดและดาวโหลด 

เราสามารถนำภาพกลับมาปรับปรุงแก้ไขใหม่ได้ 
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                              เริ่มต้นกบั Photoshop CS6 

 

 

 

 

 

 

1. ให้นักเรียนฝึกสร้างไฟล์ใหม่ ขนาด 800 pixel สูง 600 pixel  

2. ให้นักเรียนฝึกบันทึกไฟล์ภาพในรูปแบบ JPEG ตามดว้ยชื่อของนักเรียนและตามด้วยเลขที่

ห้อง (ตัวอย่าง : Photoshop–สุจิตรา–32)  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

     บัตรเฉลยกจิกรรมที่ 2 

คำชี้แจง   ให้นักเรียนปฏิบัติตามคำสั่งต่อไปนี้ (20 คะแนน)  

 

                 

 

 

 

รูปภาพนักเรียนตอนปฏิบัติงาน 

 

 

 

รูปภาพนักเรียนตอนปฏิบัติงาน 

 

**อยู่ในดุลยพินิจของครูผู้สอน โดยพิจารณาจากการปฏิบัติการทำกิจกรรมของนักเรียน** 
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เฉลยแบบทดสอบก่อนเรียน 

ข้อที่ คำตอบ 

1 ง 

2 ค 

3 ง 

4 ก 

5 ค 

6 ข 

7 ค 

8 ข 

9 ค 

10 ก 

 

เฉลยแบบทดสอบหลังเรยีน 

ข้อที่ คำตอบ 

1 ค 

2 ง 

3 ก 

4 ค 

5 ข 

6 ง 

7 ข 

8 ค 

9 ค 

10 ก 

 

เฉลยแบบทดสอบก่อนเรียน-หลังเรียน   
เรื่อง การใช้งานโปรแกรม Adobe Photoshop CS6 

รายวิชาคอมพิวเตอร์ 3 รหัสวิชา ว22282  ชั้นมัธยมศึกษาปีท่ี 2  

เล่มท่ี 1 เรื่อง เริ่มต้นกับ Photoshop CS6 
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แบบประเมินการปฏิบัติกจิกรรม 

                          เร่ือง เร่ิมต้นกับ Photoshop CS6 
 

         *********************************************************** 
 

คำชี้แจง   ให้ครูผู้สอนประเมินการทำกิจกรรมตามรายการที่กำหนด แล้วบันทึกคะแนนที่ได้ให้ตรงกับ 

              รายการประเมิน 
 

 

รายการประเมิน 
คะแนน 

คะแนนเต็ม คะแนนที่ได ้

ปฏิบัติถูกต้องตามขั้นตอน 5  

ทำได้ครบทุกข้อ 5  

ทันเวลา 5  

มีทักษะการใช้คอมพิวเตอร์ 5  

รวมคะแนน 20  
 

 

เกณฑ์การประเมินผล 
  

คะแนนที่ได้  (คะแนนเต็ม 20 คะแนน) ระดับคุณภาพ 

18 – 20  คะแนน ดีมาก 

15 – 17  คะแนน ด ี

12 – 14  คะแนน พอใช้ 

ต่ำกว่า  12  คะแนน ปรับปรุง 

 

 

 

 

 

 

เกณฑ์การประเมินการทำกิจกรรม 
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            คำนำ 

 

   

ชุดการเรียนรู้  เรื่อง การใช้งานโปรแกรม Adobe Photoshop CS6 รายวิชา

คอมพิวเตอร์ 3 รหัสวิชา ว22282  ชั้นมัธยมศึกษาปีที่  2 เล่มที่  1 เรื่อง เริ่มต้นกับ 

Photoshop CS6 เล่มนี้ จัดทำขึ้นโดยมีวัตถุประสงค์เพ่ือใช้ประกอบการเรียนรู้ของนักเรียน

ในรายวิชาคอมพิวเตอร์ 3 รหัสวิชา ว22282 ชั้นมัธยมศึกษาปีที่ 2 ทำให้การจัดการเรียนรู้

เป็นไปอย่างมีประสิทธิภาพ ซึ่งผู้จัดทำได้ศึกษาค้นคว้า รวบรวมข้อมูลจากหนังสือหลาย ๆ 

เล่ม และเว็บไซต์ที่เกี่ยวข้องมาประกอบกัน แล้วนำข้อมูลมาเรียบเรียงโดยให้สอดคล้องกับ

ผู้เรียนให้มากที่สุด เพ่ือให้นักเรียนใช้ประกอบการเรียนรู้ในห้องเรียน และศึกษาค้นคว้า

เพ่ิมเติมด้วยตนเอง ชุดการเรียนรู้ เรื่อง การใช้งานโปรแกรม Adobe Photoshop CS6 

รายวิชาคอมพิวเตอร์ 3 รหัสวิชา ว22282 ชั้นมัธยมศึกษาปีที่ 2 มีจานวน 8 เล่ม ดังนี้ 

เล่มที่ 1 เรื่อง เริ่มต้นกับ Photoshop CS6 

เล่มที่ 2 เรื่อง หลักการสร้างงานกราฟิกและใช้เครื่องมือพ้ืนฐาน 

เล่มที่ 3 เรื่อง การแต่งและตัดภาพเฉพาะส่วน 

เล่มที่ 4 เรื่อง การสร้างข้อความตกแต่งภาพ 

เล่มที่ 5 เรื่อง การทำงานกับเลเยอร์ 

เล่มที่ 6 เรื่อง การปรับแต่งภาพ 

เล่มที่ 7 เรื่อง การวาดภาพและรูปทรง 

เล่มที่ 8 เรื่อง การทำงานกับสีและการระบายสี 

ผู้จัดทำหวังเป็นอย่างยิ่งว่าชุดการเรียนรู้เล่มนี้จะเป็นประโยชน์ต่อการจัดกิจกรรม

การเรียนรู้ของนักเรียนเป็นอย่างดีและนักเรียนสามารถนำความรู้ที่ ได้ปรับไปใช้ใน

ชีวิตประจำวันได ้

     

        สุจิตรา อนันตนมณี 
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